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About DeltaLINK 3 
DeltaLINK 3 is the PC software for setting up and downloading data from GP2, GP1 and DL6 
data loggers.  

What’s new in DeltaLINK 3.5 

DeltaLINK 3.5 includes support for the new connection type “DeltaLINK-Cloud Gateway” for 
connecting to loggers via DeltaLINK-Cloud (www.delta-t.co.uk/DeltaLINK-Cloud.asp). 

 

1. The ‘GP2 Multi-function program’ sensor library includes the PR2 SDI-12 sensor. 
2. Logger errors can be copied to the clipboard. 
3. Connection dialog can now be resized and sorted by column. 
4. GP1 battery program voltage adjusted to 12V from 10V. 
5. SDI-12 terminal fixed to work over TCP/IP connections. 

 

Compatibility 

DeltaLINK 3.5 is backward compatible with earlier GP2 firmware and DeltaLINK versions, i.e. 
it can communicate with, and open programs and datasets from earlier versions.  

However, programs created in DeltaLINK 3.5 are incompatible with GP2 firmware 2.0: 

a. You can use DeltaLINK 3.5 to retrieve and view data created by firmware 2.0 without 
upgrading the firmware. 

b. You must upgrade GP2s to firmware 2.10 if you want to re-program them with DeltaLINK 
3.5.  

See Firmware Upgrade below for instructions. 

DeltaLINK 3.5 is fully compatible with GP1 and DL6 firmware 1.48 – this is the current version 
and cannot be upgraded to provide SDI-12 functionality. 

DeltaLINK 3.5 installs side-by-side with earlier DeltaLINK versions. This allows you to 
continue using earlier firmware versions with an older DeltaLINK installation if you don’t want 
to upgrade. 

Compatibility between DeltaLINK and firmware versions is summarized in the table below. 

 

DeltaLINK version: 3.5, 3.2 3.1.1 2.3 

GP2 firmware: 2.10 2.00 2.10 2.00   

GP1 and DL6 firmware: 1.48 1.47   1.48 1.47 

Logger and Sensors windows, Read Now       

Datasets       

Programs, view and save       

Programs, Change and Apply       

Installation 

System Requirements 

To install and use DeltaLINK 3 you need: 

 A PC running Windows Vista, 7, 8 or 10. 

 500MB of available hard disk space. 

http://www.delta-t.co.uk/DeltaLINK-Cloud.asp
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 One free RS232 serial port or USB-RS232 adapter, plus DL6 or GP1 RS232 cable 
(supplied with logger). 

 Or one free USB port plus GP2-USB cable (supplied with the GP2). 

To Install DeltaLINK 

You need local administrator rights to install DeltaLINK 3.5. Please contact your system 
administrator for further information. 

Open the DeltaLINK for GP2, GP1 and DL6 page of the Delta-T Software and Manuals DVD 
and select the Install DeltaLINK 3.5 link. You may also need to install the driver for the GP2-
USB cable: select the Install USB driver link.  

Alternatively, download DeltaLINK 3.5 from www.delta-t.co.uk and click Run when the 
download completes. 

The installation program creates a DeltaLINK 3.5 desktop shortcut, and a DeltaLINK 3.5 
program group in the Windows Programs menu which contains the following shortcuts: 

 DeltaLINK 3.5   for setting up, controlling, retrieving and displaying logged data. 

 Firmware Upgrade   upgrades logger firmware to the most recent version. 

 GSMConfig Utility   sets up the Delta-T GSM Modem System for use with 
DeltaLINK. 

 Document Library   opens a folder of application notes and technical documents 
which supplement the DeltaLINK online Help and the logger Quick Start Guide. 

 Calibration Certificate Generator    creates a printable GP2 calibration certificate. 

 Samples    contains sample programs and dataset which you can adapt for your own 
needs. 

To Start DeltaLINK 3 

1. Connect the logger to the PC using the cable supplied with the logger. 

2. Double-click the DeltaLINK icon on the desktop. 

3. DeltaLINK attempts to connect to a logger. If successful, DeltaLINK shows information 
about the logger in the Logger window. 

4. If you have a fresh installation, DeltaLINK attempts to use COM1. If the connection fails 
because the logger is connected to the wrong serial port select File, Properties. Click 
New... to create a connection which uses the correct serial port. Press F1 or click Help for 
more information. 

Firmware Upgrade 

To upgrade to the current firmware version: 

1. In DeltaLINK, stop logging, retrieve any stored data and delete all dataset records. 

2. Close DeltaLINK. 

3. From the Windows Start menu select Firmware Upgrade in the DeltaLINK 3.5 program 
group, and follow the on-screen instructions. 

WS-GP1 Weather Station Program 

The firmware upgrade process restores the default GP1 program (i.e. the GP1 weather 
station program is lost). To re-program the logger as a weather station, connect to the GP1 in 
DeltaLINK and follow the below steps: 

1. Select the Program page and click Change. 

2. Select Edit > New Program… (NB: Not File > New Program…). 

3. In the Program Type list, select WS-GP1 Weather Station Program. 

4. Select the weather station options that you want to record. 

5. Click Apply to update the logger in the normal way. 

http://www.delta-t.co.uk/
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Dataset Import Wizard 

Dataset Import Wizard imports DeltaLINK datasets into Microsoft Excel (32-bit) spreadsheets.  

To install Dataset Import Wizard open the Dataset Import Wizard Excel add-in page in the 
in the Delta-T Software and Manuals DVD and follow the on-screen instructions. 

Known Issues 
The following defects have been identified and will be addressed in forthcoming upgrades, 
which will be available from www.delta-t.co.uk. 

1. When replacing an earlier version, DeltaLINK Setup leaves behind a shortcut to the 
Document Library folder of the previous version. This folder is empty – unless you have 
copied or moved files into it. If so, it can be safely deleted together with the shortcut. All 
other shortcuts, files and folders are correctly removed and replaced by the current 
version. 

Revision History 

DeltaLINK 

DeltaLINK 3.5 

DeltaLINK 3.5 includes support for the new connection type “DeltaLINK-Cloud Gateway” for 
connecting to loggers via DeltaLINK-Cloud (www.delta-t.co.uk/DeltaLINK-Cloud.asp). 

 

1. The ‘GP2 Multi-function program’ sensor library includes the PR2 SDI-12 sensor. 
2. Logger errors can be copied to the clipboard. 
3. Connection dialog can now be resized and sorted by column. 
4. GP1 power max voltage adjusted from 12V to 10V. 
5. SDI-12 terminal fixed to work over TCP/IP connections. 

DeltaLINK 3.2 

The principal feature of DeltaLINK 3.2 is SDI-12 support for GP2 loggers: 

1. GP2 Program Editor offers a SDI-12 Input type 
2. Includes Firmware Upgrade for GP2 loggers to firmware 2.10 which provides SDI-12 

firmware functionality, and can be applied retrospectively to any GP2 logger. 

Other improvements include:  

3. Chart window corrections to prevent occasional ‘hanging’ when opening a dataset and to 
enable allocation of more than 63 different colours  

4. GP2 Program Editor correction to enable single-ended resistance measurements on CH 
12-. 

DeltaLINK 3.1.2 

DeltaLINK 3.1.2 is a maintenance release with a bug fix for Windows installation using non 
Western extended ASCII tables.  

DeltaLINK 3.1.1 

DeltaLINK 3.1.1 is a maintenance release with improvements to the TCP/IP connection type 
and other general changes. 

1. A timeout setting is now available in all communication types. This overrides previous 
timeout behaviour. 

2. Progress bars are now displayed when retrieving the logger’s status and sending and 
retrieving the logger’s program. 

3. COM1 is no longer the default connection when starting Delta-T for the first time. This is 
due to most PCs not having built in serial ports anymore. Instead the communication 
property dialog will appear. 

file://///dtsrvr2/groups/version%20control/private/manuals/DeltaLINK/PC/DeltaLINK-PC%20Release%20Notes/Draft/www.delta-t.co.uk
http://www.delta-t.co.uk/DeltaLINK-Cloud.asp
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DeltaLINK 3.1 

The principal new feature of DeltaLINK 3.1 is support for GPRS connections by way of a 
TCP/IP connection type.  

 

Other new features include: 

1. When a connection times out, DeltaLINK will attempt to save the downloaded data, to 
avoid having to re-download it next time. This is useful for remote connections, where the 
connection can be temperamental (e.g. internet) 

DeltaLINK 3.0 

The principal new feature of DeltaLINK 3.0 is support for the GP2 Advanced Data Logger and 
Controller. This includes: 

1. GP2 Multifunction program editor, which provides a comprehensive feature set, including: 

a. Extensive library of Delta-T sensors, complete with detailed programming and 
installation notes 

b. Flexible recording options: multiple recoding rates, statistics, wind processing 
functions (direction and vector averaging, wind roses), conditional recording 

c. Controls, with independent activate and deactivate conditions and safety conditions 

d. Alarms, threshold or condition triggered 

e. Scripts, for full customization of logging and control behaviour. 

2. GP2 Simulator, simulates most environmental and meteorological sensors and response 
applied irrigation 

Other new features include: 

3. Improved PC serial port selection, including automatic detection of USB COM ports. 

4. Corrected text file output of DL4CmdLine command line utility: now outputs in identical 
format as DeltaLINK’s File, Save As command, and always creates a new data file. 

DeltaLINK 2.6 

1. Support for SM150 soil moisture sensor. 

2. DeltaLINK program, various corrections and improvements: 

a. Corrected displaying of connection details at bottom of DeltaLINK window, previously 
connection details were only partly updating. 

b. Corrected connection start-up settings, on some PC the start-up connection setting 
were not loaded correctly, and defaulted to use last successful connection. 

c. DeltaLINK, various optimizations in chart view, data cache, data download. 

3. DL4CmdLine utility, various corrections and improvements: 

a. Added tab-separated data text files, use .txt extension for dataset file or use /X switch 
when using auto-generated filenames for multiple loggers in a single command line. 

b. DL4CmdLine now only requires only DL4Api.dll to run, so can be run on PC without 
installing DeltaLINK. 

c. Timestamps consistently written to logger errors and log file in default format for 
locale. Previously a mixture of locale-default and “YYYY-mm-dd hh:mm:ss”. Auto-
generated file name format retained as locale-default format is not guaranteed to 
provide seconds, so could lead to overwriting. 

d. Error log output to screen was untidy, so has been removed. 

e. ‘Hidden’ measurements excluded from error log. 

f. Removed trailing space from measurement names in error log 

DeltaLINK 2.5.1 

1. Corrects a problem with cancellation of Read Now which was present in DeltaLINK 2.5. 



DeltaLINK 3.5 Release Notes 

19 August 2016, Copyright © Delta-T Devices page 6 of 9  

  

DeltaLINK 2.5 

1. BF5 Sunshine Sensor support: DeltaLINK offers ‘BF3, BF5 Sunshine Recorder’ program. 

2. DL4CmdLine.exe command line: can be used in batch files and/or in conjunction with 
Windows Scheduled Tasks to automate dataset retrieval. See application note ‘Command 
line utility for automating dataset retrieval v1.0.pdf’ in the DeltaLINK document library 
(select the Document Library shortcut from the DeltaLINK 2.5 program group in the 
Windows Start menu). 

3. Connection to a logger and data retrieval is speeded up by caching programs and 
datasets from earlier sessions. 

4. A status bar displays Connection details together and provides a button for changing the 
logger connection (as File, Properties command).  

5. The Connections dialog provides connection start up options. These are alternatives to 
using the last successful connection, as in earlier versions. 

6. The known issue ‘Unable to Allocate Memory for FlexGrid’ has been resolved and the 
Table view can now display large datasets. 

Version 2.4 

1. Support for SM300 soil moisture sensor. 

2. Enhanced Control features in Standard GP1 and DL6 programs: 

a. SINCE SWITCHED condition for limiting the maximum and minimum repeat rate and 
duration of relay activation and deactivation. 

b. Totalizing counter-based measurements in Control conditions 

c. Named Control values which can be adjusted while the program runs, i.e. without 
stopping and re-programming the logger. 

See Application Note ‘Irrigation and Control features in DeltaLINK 2.4’. Start DeltaLINK 
and select Help > Document Library command.  

3. DL6 and GP1 simulators for experimenting with effects of Control conditions, rapid 
generation of datasets (e.g. for developing data processing regimes), and predicting 
memory usage. Start DeltaLINK and see Help topic ‘How To… Run GP1 and DL6 
program simulations’. 

4. Firmware upgrade version 1.48 is provided with DeltaLINK 2.4.  

5. Corrected importing of WET calibration and user-defined linearization table files non-
English Windows installations (‘.’ decimal separator is required in user-defined 
linearization tables, as in the specimen files provided with DeltaLINK). 

DeltaLINK 2.3.2 

DeltaLINK 2.3.2 is a service release to improve DeltaLINK’s communications stability with 
loggers over long cables either directly connected to the computer of via modems. 

DeltaLINK 2.3.1 

DeltaLINK 2.3.1 is a service release, which addressed the following issues in DeltaLINK 2.3. 

1. Correction to % soil moisture measurements in Standard GP1 programs. Previously, 
when modifying a program (i.e. a program installed in a GP1 or previously saved to disk), 
the % calculation wasn’t applied correctly. Note that DL6 programs, and newly created 
GP1 programs were not affected. 

2. Correction to Firmware Upgrade: the upgrade supplied with DeltaLINK 2.3 wasn’t able to 
upgrade from firmware versions earlier than 1.31. 

3. Chart window resizing: when increasing the size of the DeltaLINK window, charts are 
automatically scaled to better utilize the display area. 

Version 2.3 

1. WS-GP1 Weather Station program together with enhanced charting facilities for weather 
station data including wind roses, bar charts, and maxima and minima. 

2. Extended sensor support in Standard GP1 programs: 
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a. WET sensor: requires GP1-06-001 or later. Refer to WET GP1 Logging v1.2.pdf in 
the DeltaLINK Document Library.  

b. Temp3 and Temp4 channels can be used for SM200 sensors, allowing up to 4 
SM200s to be connected to the GP1. 

c. Event5 channel can be used for measuring frequency. The signal is measured over a 
200 ms sample period, so is suitable for sensors with a kHz output. 

d. Precision 5V excitation is available for powering sensors, as an alternative to 
switched power. 

3. Timing in Standard GP1 programs: 

e. Recording delay allows program actions to be offset from ‘natural’ recording rate 
boundaries, e.g. every hour at 10 minutes past the hour. 

f. Time of day can be used in Control conditions. 

4. Logger firmware versions and DeltaLINK compatibility:  

g. Current versions are GP1 v1.46 and DL6 v1.31. Firmware Upgrade (above) describes 
how to upgrade existing loggers. 

h. To program a logger with DeltaLINK 2.3 the current firmware version must be 
installed in the logger.  

i. Other DeltaLINK 2.3 features are compatible with earlier firmware versions.  

j. DeltaLINK 2.3 installs ‘side by side’ with earlier DeltaLINK versions, so it’s only 
necessary to upgrade existing logger firmware if you want make use of the new 
program features in DeltaLINK 2.3. 

5. Firmware Upgrade supports logger networking. 

6. Added support for use of COM ports greater than COM10. 

Version 2.2 

Version 2.2 provides the following additional features: 

Standard GP1 and DL6 programs: 

1. Control Page: the active state of the Control relay can be set to open or closed. 

2. Condition dialog: counter channels can be selected in Control conditions. Note that 
counter channel readings are cumulative during the course of a recording period, so 
Control relay switching will track the incrementing and resetting of the counter.  

3. Dual Rate page: accelerated recording rate can now be triggered by activation of the 
Control relay, and by GP1 Event5 channel. When triggered by the Control relay, 
accelerated recording (of soil moisture channels only), starts when the relay is activated 
and persists for a holdoff period after the relay is deactivated, and until soil moisture 
readings stabilize. 

4. Alarm page: the initial state of the Alarm relay can now be set to open or closed. 

5. Relay state recording: when logging, the state of the control relay is recorded whenever 
the relay switches. 

GP1 Irrigation Monitor and Switch program: 

6. Control Page: the active state of the Control relay can be set to open or closed. 

7. Control Page: if irrigation control is enabled, and the deactivate condition is monitored 
more frequently than the normal recording rate, the program records soil moisture at the 
more rapid recording rate. This requires the deactivate condition to be monitored at a rate 
which is a divisor of the normal recording rate. 

8. Relay state recording: when logging, the state of the Control relay is recorded whenever 
the relay switches. 

Sunshine Recorder programs for GP1:  

9. SPN1 Sunshine Pyranometer: added SPN1 Sunshine recorder program. 
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10. Recording options: added averaging and alternative irradiance and sunshine duration 
units to. 

11. Sample and recording rates: recording rate can be equal to sample rate, for recording 
instantaneous values. 

12. Battery life: power consumption is reduced and battery life increased by a factor of 5 
(approximately). This is achieved by a reduced warm up time. 

Other changes: 

13. Printing correction: on some PC systems, printed charts contained missing point markers 
and/or partially printed charts with blacked out or blank areas. 

14. GSMConfig Utility: is now provided with DeltaLINK, for setting up modems for use with 
DL6 and GP1 loggers. 

15. Counter channels: when not logging, counter channels automatically reset when they 
overflow the maximum value stipulated for the channel. This change allows the user to 
use counter channels to control the relay (see below) and to exercise the relay operation 
before starting logging. Note that; 
a) previously, counter channels incremented indefinitely until reset, or logging started 
b) when logging, counters are only reset when recorded and this behaviour is unchanged. 

16. Dataset window: the Save As dialog doesn’t now save text files with the.dt6 suffix. 

17. Dataset and Sensors windows: provides a binary state chart for e.g. state of a Control 
relay. 

18. Networking: the Connection Properties dialog allows a logger serial number to be 
selected, for addressing an individual logger from a network. All loggers on a network 
need to have firmware version 1.30 or later. 

19. Modem communication: the communication protocol is more robust against extended 
pauses, such as can occur in GSM modem connections. 

20. File, Send To Logger: correctly refreshes Sensors and Program windows. Previously the 
Sensors window showed ‘garbage’ text, and the Program window could be left with a 
stale copy of the previously installed program. 

21. Closing DeltaLINK: closing the last window sometimes failed to shut down DeltaLINK, and 
sometimes caused an Application Error. 

Version 2.1 

Version 2.1 fully supports the DL6 logger (as well as the GP1) and replaces DL6 Control 
Panel, offering the following major additional features: 

1. Support for SM200 soil moisture sensor. 

2. Advanced Control option in Standard DL6 programs (requires firmware upgrade to 
version 1.27, see below). 

3. Imports linearization tables from user-defined .TBL files.  

Refer also to DeltaLINK Application Note ‘DL6 Control Panel, DeltaLINK and Timestamp 
Issues’ for advice about migrating to DeltaLINK. 

Additional improvements over Version 2.0 are: 

4. Supplied with firmware (GP1 and DL6) upgrades to version 1.27. See below for details. 

5. Improved estimation of dataset memory usage and predicted time to fill (requires 
firmware 1.27).  

Version 2.0 

This is the first public release of DeltaLINK for the GP1 logger.  

However Dataset Import Wizard is version 1.5, which differs from earlier versions which were 
supplied with DL2e, DL6 loggers and the HH2 meter. 

1. Dataset Import Wizard 1.5 offers ‘DeltaLINK dataset files’. 
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2. Dataset Import Wizard 1.5, step 6, Options offers ‘Import serial number’, which includes 
DL6 or GP1 serial numbers in the header of each data series column and allocates 
separate columns for data series from different loggers.  

GP2 Firmware 

Version 2.10 

This is the current version of GP2 firmware. Its principal feature is support for the SDI-12 
sensors.  

Firmware 2.10 requires DeltaLINK 3.2 or later. It is not available for DL6 or GP1 loggers.  

Other features include: 

1. Correction of a fault which caused repeated occurrences of ‘watchdog timeout’ error in 
some GP2s.  

Version 2.00 

This was the first version of GP2 firmware.  

GP1 and DL6 Firmware 

Version 1.48 

This is the current version of GP1 and DL6 firmware.  

Version 1.48 is required for the new features provided in DeltaLINK 2.4, and is incompatible 
with programs created in earlier DeltaLINK versions. 

Version 1.47 (GP1 only) 

1. Optimization of quiescent current consumption.  

Version 1.46 (GP1 only) 

1. Supports WS-GP1, WET sensor and other new features provided in DeltaLINK 2.3. 

Version 1.31 

1. Allows loggers to be individually addressed when connected together on a network. 

2. Prevents spurious switching of Alarm relays when Read Now is clicked in the Sensors 
window. This was caused by insufficient warmup time before the initial reading which 
controls the relay. 

Version 1.27 

1. Provides improved information about dataset memory usage, for use with DeltaLINK 2.1. 

2. Correction to DL6 relay switching, required for the Advanced Control feature. 

3. Is not vulnerable to crashing when used with DL6 Control Panel after being programmed 
with DeltaLINK. 

Version 1.25 (GP1 only) 

This is the first public release of GP1 firmware. 

Version 1.03 (DL6 only) 

1. Accuracy of resistance measurements is improved. 

Version 1.02 

This is the first public release of DL6 firmware. 

 


